This Administrator’s Reference describes how to integrate hp OpenView Storage Area Manager with hp OpenView Operations for Windows.
# Contents

**Introduction** .......................... 7

- About hp OpenView storage area manager ........................................ 8
- Device discovery and mapping ...................................................... 8
- Event management ................................................................. 8
- Manager of Managers .............................................................. 9
- User authentication and authorization ........................................... 9

**Storage Node Manager** ......................................................... 10

- Device status monitoring ......................................................... 10
- Application linking ............................................................... 10

**Storage Optimizer** .............................................................. 10

- Performance views ............................................................... 10
- Top-N analysis ................................................................. 11
- Past and future trends .......................................................... 11
- Performance thresholds and threshold events ................................ 11
- Data export ................................................................. 11

**Storage Builder** ................................................................. 11

- Capacity data for host resources .............................................. 11
- Capacity views ................................................................. 12
- Past and future usage trends .................................................. 12
- Capacity thresholds and threshold events .................................. 12
- Data export ................................................................. 12
- File Analysis ................................................................. 12

**Storage Accountant** .......................................................... 13

- Service Level, Organization and Account nodes in the Applications tree 13
- Centralized setup functions .................................................... 13
- Monthly and interim bill reports ............................................. 13
- Storage device and service level billing reports ......................... 13
- Exported bills ................................................................. 14

**Storage Allocator** .............................................................. 14

- Security Groups ............................................................... 14
Assigning user roles ................................................................. 41
Deploying instrumentation to the nodes .................................. 43
Setting up service discovery ...................................................... 45
Setting up automatic acknowledgement .................................... 48

**Using** .................................................................................. 51
The hp OpenView storage area manager SPI node folders .......... 52
The hp OpenView storage area manager SPI tools ...................... 54
The hp OpenView storage area manager SPI policies .................. 56
The hp OpenView storage area manager SPI messages ............... 61
  Launching the Storage Area Manager GUI from the message browser 63
The hp OpenView storage area manager SPI user roles ............... 64
The hp OpenView storage area manager SPI services ................. 65
  Viewing services ..................................................................... 67
The hp OpenView storage area manager SPI Self-Healing Services 68
  Deploying OpenView SAM SHS Data Collector and SHS Data Collector 68
  Using the Self-Healing Information tool .................................. 69
  Self-Healing Services Software and Online support ................. 71
    Download the Self-Healing Services Software ....................... 71
    Registering With Self-Healing Services Software .................. 71

**Troubleshooting** ................................................................. 73
Before you start ........................................................................ 74
OpenView SAM SPI messages not arriving on the OVO management server 75
OpenView SAM services not visible in the OVO console .............. 76
Messages in the annotation field .............................................. 77
Context Sensitive GUI launch is not working .............................. 78
Automatic Acknowledgement is not working ............................. 79

**Uninstalling** ....................................................................... 81
Uninstalling the OpenView SAM SPI Policies from the OVO managed nodes 82
Uninstalling the OpenView SAM SPI from the OVO management server 84
Uninstalling the OpenView SAM SPI User Role from the OVO GUI .... 87
Introduction

- About hp OpenView storage area manager, page 8
- hp OpenView storage area manager architecture, page 16
- hp OpenView storage area manager user interfaces, page 19
- What is hp OpenView storage area manager SPI?, page 23
- Features and functionality of hp OpenView storage area manager SPI, page 25
About hp OpenView storage area manager

HP OpenView Storage Area Manager provides comprehensive, centralized management across distributed, heterogeneous storage networks. The Storage Area Manager product suite includes the following five applications: Storage Node Manager, Storage Optimizer, Storage Builder, Storage Accountant, and Storage Allocator.

These applications work within a framework that is available regardless of which applications are installed and licensed. Among other features, this framework provides:

Device discovery and mapping

Storage Area Manager automatically discovers hosts, interconnect devices, and storage devices in direct attached (Fibre Channel or SCSI) and networked storage (SAN and NAS) environments. Discovered devices are placed in the Resources tree and a device map. Storage Area Manager illustrates the relationship of these devices by displaying their links within each device map.

If the storage network is using interconnect hardware to support fabric zoning, Storage Area Manager identifies the pre-configured zones and lists them under the Storage Networks node in the Resources tree. Storage Area Manager also creates a corresponding device map of each zone.

Event management

Based on its status inquiries of the storage network and its own processes, Storage Area Manager generates and displays events in the event panel. Framework and discovery-related events are displayed regardless of which applications are installed and licensed. Device status, performance, capacity, billing, and LUN security related events only appear if the applicable application is installed and licensed.
Storage Area Manager is able to receive SNMP traps from devices that support trap forwarding. You can also configure event triggers to perform certain actions based on event criteria. For example you can configure an event trigger to send e-mail notification to your on-call administrator for all events of a particular severity level.

Storage Area Manager also provides several features to manage the events that appear in the event panel. You can configure filters so only events that meet the filter’s criteria are displayed in the event panel. You can also export all or selected events to a .txt, .csv, or .xml file. Finally, you can configure Storage Area Manager to automatically delete events based on a maximum number or on certain criteria such as event age, event severity level, or event category.

Manager of Managers

The Manager of Managers (MoM) enables you to monitor several storage domains from one console. You can configure MoM to retrieve and display status and event information from each Storage Area Manager management server in your environment. This feature allows Storage Area Manager to easily scale in large, complex storage environments.

User authentication and authorization

When starting Storage Area Manager, users must login with their unique user name and password. A Storage Area Manager user account can be configured with different levels of privilege. User accounts with Administrator privilege are able to save changes to the Storage Area Manager database and may perform all Storage Area Manager tasks. User accounts with Guest privilege are only able to view information provided by Storage Area Manager, and are not able to save changes. User account privileges apply to tasks conducted both through the graphical user interface (GUI) and command line user interface (CLUI).
Storage Node Manager

Storage Node Manager provides device status monitoring and reporting capability to the Storage Area Manager product suite. Among other features, Storage Node Manager provides:

Device status monitoring

Storage Node Manager monitors and graphically displays the status of each discovered device in your storage network. Device status is displayed wherever the device is referenced in the user interface, including the Resources tree, device map, and event panel.

Based on its status inquiries of the storage network, Storage Area Manager generates and displays status-related events as they occur in your storage network.

Application linking

You can link device-specific applications to Storage Area Manager and then start them from the user interface. The applications are linked to specific devices or device models. Many default device-specific application links are provided with Storage Node Manager.

Storage Optimizer

Storage Optimizer monitors and reports device performance in a storage network. Performance metrics vary by device; however, a set of common metrics are available for all devices supported by Storage Optimizer. Among other features, Storage Optimizer provides:

Performance views

Performance views for host disks, volumes, interconnect devices, ports, storage devices, and LUNs. Performance lists, displayed for groups of devices in the Resources tree, allow you to compare common metrics for all disks, volumes, storage devices, and so on. Performance charts show you the performance analysis of individual devices over time.
Top-N analysis

You can sort performance lists by order of performance and limit the length of the list to the first 5, 10, 15, and so on to 100 devices.

Past and future trends

Performance charts display a line graph of past and future performance. Storage Optimizer predicts future performance by identifying trends in past data. You can turn this feature on or off, and you can select from a full range of predictive models.

Performance thresholds and threshold events

Storage Optimizer monitors the current and predicted performance of individual resources for threshold violations. If performance differs significantly from a mathematically derived baseline, Storage Optimizer sends a threshold violation to Storage Area Manager’s event panel. Administrators can turn baselines on or off and configure event triggers.

Data export

You can save the contents of performance charts in a comma-delimited (.csv) file.

Storage Builder

Storage Builder monitors and reports storage capacity in a storage network. It routinely discovers the physical capacity of storage devices and logical capacity of hosts and NAS devices, and analyzes the information for current usage, past and future usage trends, and threshold violations. Among other features, Storage Builder provides:

Capacity data for host resources

Host resources include directories, disks, users, volumes, and volume groups. Clicking any of these labels in the Resources tree displays a list of the individual resources and their capacities. Selecting a resource from the list displays additional information about the individual directory, disk, user, and so on.
Capacity views

For hosts and NAS devices, view panels show the used and free file space. For storage devices, view panels show the disk space that is visible to hosts, that is unformatted, and that is spent in overhead. At the group level in the Resources tree—the domain Hosts, NAS Devices, and Storage Devices nodes Capacity view panels display summarized capacity information for the corresponding resources.

Past and future usage trends

From the Capacity view panel, you can display a line graph of past and future capacity. Storage Builder predicts future capacity by identifying trends in past data. You can turn this feature on or off, and you can select from a full range of predictive models.

Capacity thresholds and threshold events

Storage Builder monitors the current and predicted capacity of individual resources for threshold violations. If measured capacity exceeds or falls below a specified target, Storage Builder sends a threshold violation to Storage Area Manager’s event panel. Administrators can set thresholds and configure event triggers.

Data export

You can save the contents of capacity graphs and pie charts in a comma-delimited (.csv) file.

File Analysis

You can generate a report on stale files, junk files, the largest files, largest directories, and all files and directories on each and all hosts in the domain. You can modify the default reports and create original reports.
Storage Accountant

Storage Accountant meters storage space in organization accounts and reports the associated cost at the end of each month. Accounts belong to internal or external organizations. Among other features, Storage Accountant provides:

Service Level, Organization and Account nodes in the Applications tree

Storage Accountant associates LUNs with service levels and then associates the service-rated LUNs with organization accounts. You can view, create, add LUNs to, and maintain service levels and organization accounts from these nodes.

Centralized setup functions

The Accounting view panel provides all the tools you need to set up storage billing. You can view, create, and add LUNs to service levels; view and create organizations; add organization accounts; and attach LUNs to accounts. You can also view the total number of service levels, organizations, LUNs in service levels, and the total storage value that is billed and not billed.

Monthly and interim bill reports

Storage Accountant rolls up daily charges into a monthly bill that is arranged by organization and account. Detailed bills describe the charges for each LUN. Summary bills show only the total charges for each organization and account. Using the Bill Viewer, you can view, export, and print bills for the current (interim) or past billing periods and for all or individual organizations.

Storage device and service level billing reports

Storage Accountant creates monthly billing reports that are organized by storage device or service level. Summary reports show the total charges for the storage device or service level LUNs in accounts and LUNs not in accounts. Detailed reports show summary information and a LUN-by-LUN description of charges.
Exported bills

Storage Accountant automatically exports monthly bill reports in a format and location that you choose. Available formats include CSV, HTML, and XML. You can set event triggers that launch a third-party billing application once the report is exported.

Storage Allocater

Storage Allocater controls storage access and provides security by assigning logical units (LUNs) to specific hosts or groups. Assigned LUNs cannot be accessed by any other hosts. With this application, you can assign, unassign, and reassign storage and related devices from a diverse pool. Among other features, Storage Allocater provides:

Security Groups

Share groups and associated LUN groups streamline your storage assignments. Share groups allow multiple hosts to share the same storage devices. Associated LUN groups keep sets of logical units (for example, stripe sets or mirror sets) together, requiring them to be assigned and unassigned as a unit.

Organizational Groups

Host groups and LUN groups allow you to arrange hosts and logical units into hierarchical groups in the Storage Area Manager user interface.

Reports

Storage Allocater can generate reports that show all LUNs, assigned LUNs, or unassigned LUNs. These reports allow you to quickly view the assignment status of all of the LUNs in the current storage domain.
System availability

Storage Allocator provides increased system availability by enabling storage to be assigned, unassigned, and re-assigned without reboots.

Automation of LUN allocation operations

Hooks in the Storage Area Manager command-line interface allow you to automate LUN allocation operations with scripts.
Introduction

hp OpenView storage area manager architecture

Storage Area Manager’s hardware and software architecture consists of the bridge, management server, managed host(s), management client(s), and the Manager of Managers (optional). This section offers an overview of each of these elements.

Figure 1: hp OpenView storage area manager Architecture

Bridge

The Storage Area Manager bridge is a web server application that allows other applications access to Storage Area Manager’s functionality. This access enables Storage Area Manager to have tight integration with other hp OpenView enterprise applications. The bridge is able to consolidate information from multiple management servers for use by the application integrating with the bridge.
The bridge is automatically installed on the management server when you install Storage Area Manager from the CD.

**Management Server**

The management server is a server application that hosts the majority of Storage Area Manager functionality. This framework includes Storage Area Manager’s database, discovery subsystem, event handling subsystem, configuration files, and server components for each of the five applications that comprise the product suite.

The management server software is installed from the Storage Area Manager CD on a dedicated Windows 2000 server or workstation. One management server manages a single storage domain. A storage domain consists of storage resources that are visible to the SAN hosts associated with the management server. Storage Area Manager is capable of managing direct-attached, SAN-attached, or network-attached storage resources.

**Managed Host**

The managed host contains the host agent software, which includes all components that require access to the storage resources that are visible to the hosts. These components include discovery, status and event inquiry, and performance and capacity data collection.

The host agent software can be installed remotely from the management server or locally from the Storage Area Manager CD on to a Windows, HP-UX, Solaris, Linux, AIX, Tru64 Unix, OpenVMS, and Netware hosts. Upon successful installation, the host becomes associated with and dedicated to the management server. The host agent runs as a service on Windows hosts and as a daemon on Unix hosts.

**Management Client**

The management client is a graphical user interface (GUI) application that uses a common navigation and presentation framework to display the storage information that is stored by the management server.
The management client software is automatically installed on the management server. The management client can also be downloaded from the management server to remote client systems running Windows, HP-UX, Solaris, or Linux.

**Manager of Managers**

The Manager of Managers (MoM) is a graphical user interface (GUI) application that consolidates storage information from multiple storage domains. This allows an administrator to view from a single location the high-level status and filtered event information of a large or geographically dispersed storage network. The administrator can also launch the management client for a particular storage domain to view the detailed information displayed by the client.

The MoM software can be downloaded from the management server to remote Windows, HP-UX, Solaris, and Linux hosts. It is an optional piece of the Storage Area Manager architecture.

**OpenView Enterprise Applications**

Storage Area Manager integrates with various OpenView enterprise applications. Through the bridge, the Storage Area Manager SMART Plug-In (SPI), and the integration packages contained on the Storage Area Manager CD, Storage Area Manager information and control can be integrated with:

- hp OpenView Reporter (OVR)
- hp OpenView Service Information Portal (SIP)
- hp OpenView Operations for Windows (OVW)
- hp OpenView Operations for Unix (OVO)
- hp OpenView Internet Usage Manager (IUM)
- hp OpenView Service Navigator
- hp OpenView Service Activator
- hp OpenView Service Desk
hp OpenView storage area manager user interfaces

Storage Area Manager provides two interfaces within which you can perform storage management tasks: the graphical user interface (GUI) and the command line user interface (CLUI).

Graphical User Interface

Storage Area Manager’s intuitive, tri-pane GUI allows you to monitor the status of your storage network, view event information, and easily perform administrative tasks. Figure 2 illustrates some of the key elements of the Storage Area Manager GUI.

![hp OpenView storage area manager GUI](image)

**Figure 2: hp OpenView storage area manager GUI**

**Title bar**

The title bar indicates the node or subnode currently selected in the tree panel and the product name. For example, “DEFAULT_DOMAIN - hp OpenView storage area manager”.

---

Smart Plug-In for hp OpenView Storage Area Manager Administrator’s Reference for HP OpenView Operations on Windows administrator’s reference 19
Menu bar and toolbar

The menu bar and toolbar provide access to commonly performed tasks. Application icons are included on the toolbar, which provide direct navigation to each application’s home page.

Tree panel

The tree panel includes two views, Resources and Applications, which are controlled by the Tree panel tabs at the bottom of the tree panel.

- The Resources tree lists resources managed by the storage domain including storage networks, devices, and organizations. Storage networks are defined as islands of Fibre Channel connectivity, which indicates that each device in the storage network is able to send Fibre Channel commands to all other devices in the storage network. Each storage network is represented by a corresponding device map.
  
  Device types include hosts, interconnect devices, bridges, storage devices, NAS devices, and unknown devices.
  
  Organizations include various resources in their membership and are used by Storage Accountant as part of its billing functionality.

- The Applications tree includes a node for each of the five applications that make up the Storage Area Manager product suite. Each application node includes shortcut navigation to that application’s primary tasks.

Event panel

The event panel lists events received and reported by Storage Area Manager as it monitors the storage network. Each event listed in the event panel includes its severity level, the date and time it occurred, the source of the event, the event’s category and type, and the message provided by the event itself.

Storage Area Manager’s event management subsystem enables several features to help you manage the events displayed in the event panel. These features are conducted through use of the toolbar icons near the top of the event panel and include such tasks as acknowledging, deleting, and exporting events. You can also create event filters, which enable you to display only those events that meet the criteria you set when creating the event filter.
**View panel**

The view panel displays detailed content for the node or subnode that is currently selected in the tree panel.

This may include lists (for example, a list of all storage devices), specific device properties information (for example, identifying information for a particular disk array), device capacity or performance data (for example, the amount of unconfigured space for a particular disk array), or device maps that illustrate the storage network.

Tabs near the top of the view panel provide navigation to other areas of content for the displayed device.

**Application indicator**

The application indicator reflects which application’s information is currently displayed in the view panel.

**Discovery indicator**

The discovery indicator reflects if Storage Area Manager’s ongoing device discovery process is on or off.

**Command Line User Interface**

Storage Area Manager’s CLUI provides an alternative interface to the GUI. Nearly all tasks that can be performed in the GUI can also be performed from the CLUI.

Like the GUI, the tasks that can be performed within the CLUI are restricted by the Storage Area Manager applications that are installed and licensed and by the privileges assigned to the user name that is used to log into the CLUI.
The CLUI offers several forms of assistance for each command including purpose statements, help text, and man pages.

- Purpose statements offer a high-level description of the command. To view the purpose statement for a particular command, enter:

  `purpose <"command name">`

**Note:** You must include the command name in quotes (""") when running the purpose command. This is not required for the help text or man page commands.

- Help text offers detailed usage information for each of the command’s options and arguments. To view the help text for a particular command, enter:

  `help <command name>`

- Man pages are the highest level of assistance for each command. Each man page includes an expanded description of the command, its options and arguments, the license and user account privilege required to run the command, an example, and a list of other CLUI commands that are closely related to this command. To view the man page for a particular command, enter:

  `man <command name>`
What is hp OpenView storage area manager SPI?

The HP OpenView SMART Plug-In for HP OpenView Storage Area Manager is a software product which, by means of a full integration with OpenView Operations for Windows (OVO)—a market-leading management solution for networks, systems, databases, and applications in heterogeneous IT environments—extends OVO’s management scope to include systems managed by hp OpenView Storage Area Manager. Installed in an environment consisting of one or more OVO servers and one or more OVO managed nodes, the Storage Area Manager SPI can be used to monitor and manage the functionality of Storage Area Manager.

The HP OpenView SMART Plug-In for HP OpenView Storage Area Manager integrates OpenView Operations with the hp OpenView Storage Area Manager by:

1. forwarding storage events from Storage Area Manager into OVO, and
2. monitoring and controlling the services and daemons of Storage Area Manager.

This allows a storage network to be proactively monitored and managed from one central point; the OpenView Operations management server console. Once configured, the Storage Area Manager SPI allows OVO operators to react to problems in the storage network before the problems become serious enough to affect applications, and ultimately the end-users.

Storage Events are stored in the Storage Area Manager SOLID database and also logged into an ASCII log file on the Storage Area Manager management server. OVO intelligent agents are installed, configured and running on the Storage Area Manager management server and Host Agent servers, which are managed nodes in the OVO management domain.
The Storage Area Manager SPI intercepts, analyzes and filters storage events in the ASCII log file and forwards this to the OVO management server. The OVO agent monitors the availability of the Storage Area Manager processes at periodic intervals and forwards appropriate events to the operator if they are not running.

The Storage Area Manager SPI also has the ability to discover the Storage Area Manager related Services. This enables operators to perform root-cause analysis of all the essential Storage Area Manager services and failure of links between different managed devices in the SAM storage environment.

**A note on integration with Service Desk**

The Storage Area Manager SPI utilizes the integration of Service Desk with OVO to forward Storage Area Manager specific events to Service Desk. The Storage Area Manager SPI templates have been modified in order to forward events to Service Desk as incidents, provided the Service Desk integration is present on the OVO management server. No changes to the templates are required for forwarding Storage Area Manager events to Service Desk.

*Note:* For more details on how to integrate hp OpenView Storage Area Manager with Service Desk, refer to the *hp OpenView storage area manager Service Desk integration administrator’s reference.*
Features and functionality of hp OpenView storage area manager SPI

The HP OpenView SMART Plug-In for hp OpenView Storage Area Manager includes the following features:

- Monitoring changes to the Storage Area Manager storage events file CS-EventExport.log: The SPI intercepts the storage event entries available in the log file and forwards only events of significance, while suppressing the others. The SPI also associates actions and instructions to the operator with the events.

- Monitoring changes to the acknowledged Storage Area Manager storage events file CS-EventAckDelExport.log: The SPI intercepts the acknowledged storage event of significant entries, while suppressing the others available in the log file and acknowledges the corresponding event on the OVO message browser.

- Process monitoring of the Storage Area Manager management server, Storage Area Manager Embedded DB service, and Storage Area Manager bridge service.

- Process monitoring of the Host Agent and OpenDial services on Windows managed nodes.

- Process monitoring of the Host watchdog, Host Agent and OpenDial daemons on UNIX managed nodes.

- Limited application control by supplying tools to launch the Storage Area Manager GUI and also tools like 'HostAgent Stop' etc.

- Discovery of OpenView SAM service: The SPI has the ability to discover the services between various storage elements present in the storage domain. Events related to the failure of critical services get mapped to the appropriate elements in the Service map helping the administrator diagnose the problem.

- Discovery of Storage Links Service: The SPI has the ability to discover the links between various storage elements present in the storage domain. Events related to the failure of links between managed devices in the storage domain get mapped to the appropriate elements in the Service map helping the administrator diagnose the problem.

- A wide range of applications [like ManagementServer stop, HostAgent Status, Backup Database etc.] for quick and easy execution of common Storage Area Manager related operating tasks.
Self-Healing Services - The SPI is integrated with OpenView Self-Healing Services to provide improved troubleshooting, by collecting data and system information relevant to the fault at the time that the fault occurs. The Self-Healing data can be collected either through HP OpenView Self-Healing Services client software or through the Self-Healing Information tool.
Installation

- Installation prerequisites, page 28
- Installing the hp OpenView storage area manager SPI, page 32
- Upgrading the hp OpenView storage area manager SPI, page 34
- Verifying the installation of the hp OpenView storage area manager SPI, page 35
- Installed file locations, page 36
Installation prerequisites

This section lists the prerequisites for the installation of the Storage Area Manager SPI. To avoid problems during the installation of the Storage Area Manager SPI software, it is essential that you read this section, and any other documents recommended in the section before you start the installation process.

Hardware requirements

For a detailed list of hardware requirements on the:

- OVO management server, refer to the *HP OpenView Operations for Windows Installation Guide*
- OVO managed node, refer to the *HP OpenView Operations for Windows Installation Guide*

**Table 1: Disk Space Requirements**

<table>
<thead>
<tr>
<th>Machine</th>
<th>Operating System</th>
<th>Installation</th>
<th>Runtime Files</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVO management server (includes documentation)</td>
<td>Windows 2000 Windows 2003 (32-bit)</td>
<td>2 MB</td>
<td>2 MB</td>
<td>4 MB</td>
</tr>
<tr>
<td>OVO managed node</td>
<td>Windows NT Windows 2000 Windows 2003 (32-bit)</td>
<td>1 MB</td>
<td>1 MB</td>
<td>2 MB</td>
</tr>
</tbody>
</table>
Note: No additional memory (RAM) is required either on the OVO management server or on the managed nodes.

Software requirements

The following table lists the versions of Storage Area Manager, OVO management server and OVO managed nodes supported by the Storage Area Manager SPI.

Table 2: Storage Area Manager Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Storage Area Manager Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000</td>
<td>03.10.xx and 03.20.xx</td>
</tr>
<tr>
<td>Windows 2003 (32-bit)</td>
<td>03.20.xx</td>
</tr>
</tbody>
</table>

Table 3: Storage Area Manager Host Agent Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Storage Area Manager Host Agent Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>03.10.xx</td>
</tr>
<tr>
<td></td>
<td>03.20.xx</td>
</tr>
<tr>
<td>Windows NT</td>
<td>X</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>X</td>
</tr>
<tr>
<td>Windows 2003 (32-bit)</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.00</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.11</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.23</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.23 PI</td>
<td>X</td>
</tr>
<tr>
<td>Tru64 4.0F</td>
<td>X</td>
</tr>
<tr>
<td>Tru64 5.1A</td>
<td>X</td>
</tr>
<tr>
<td>Tru64 5.1B</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 2.7</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 8</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 9</td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 3: Storage Area Manager Host Agent Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Storage Area Manager Host Agent Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>03.10.xx</td>
</tr>
<tr>
<td>AIX 4.3.3</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.1</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.2</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.3</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux 7.1</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux Advanced Server 2.1</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux Advanced Server 3.0</td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 8</td>
<td>X</td>
</tr>
</tbody>
</table>

### Table 4: OVO Management Server Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>OVO Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000</td>
<td>A.07.50</td>
</tr>
<tr>
<td>Windows 2003 (32-bit)</td>
<td>A.07.50</td>
</tr>
</tbody>
</table>

### Table 5: OVO Agent Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>OVO Agent Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A.07.2x</td>
</tr>
<tr>
<td>Windows NT</td>
<td>X</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>X</td>
</tr>
<tr>
<td>Windows 2003 (32-bit)</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.00</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.11</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.23</td>
<td>X</td>
</tr>
<tr>
<td>HP-UX 11.23 PI</td>
<td>X</td>
</tr>
<tr>
<td>Tru64 4.0F</td>
<td>X</td>
</tr>
</tbody>
</table>
Table 5: OVO Agent Supported Versions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>OVO Agent Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A.07.2x</td>
</tr>
<tr>
<td>Tru64 5.1A</td>
<td>X</td>
</tr>
<tr>
<td>Tru64 5.1B</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 2.7</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 8</td>
<td>X</td>
</tr>
<tr>
<td>Solaris 9</td>
<td>X</td>
</tr>
<tr>
<td>AIX 4.3.3</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.1</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.2</td>
<td>X</td>
</tr>
<tr>
<td>AIX 5L 5.3</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux 7.1</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux Advanced Server 2.1</td>
<td>X</td>
</tr>
<tr>
<td>RedHat Linux Advanced Server 3.0</td>
<td>X</td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 8</td>
<td>X</td>
</tr>
</tbody>
</table>

Software prerequisites on the OVO management server

Ensure that the following software is installed on the OVO management server system:

- *hp OpenView storage area manager client*

To verify that the Storage Area Manager client is installed on the system, do the following:

1. Click on **Start -> Settings -> Control Panel**
2. In the Control Panel Window, double-click **Add/Remove Programs** and look for the following entry:

   HP OpenView Storage Area Manager Client
Installing the hp OpenView storage area manager SPI

The Storage Area Manager SPI can be installed using the *HP Openview New and Upgraded Smart Plug-ins installer CD*. The Installer executable verifies whether OVO is installed, installs the package and uploads the configuration into OVO.

To install the Storage Area Manager SPI software bundle on the OVO management server, complete the following steps:

1. Ensure that the OVO management server system where you want to install the Storage Area Manager SPI meets Installation prerequisites. For more information, see Installation prerequisites.

2. Login to the OVO management server as a user having Administrator privileges.

3. Insert the *HP OpenView New and Upgraded Smart Plug-ins, Volume 2 CD* into the CD drive. The installation wizard appears.

4. In the Product Selection window, select **SPI for Storage Area Manager** and click **Next**. Figure 3 displays the SPI Installation window.

5. Follow the instructions as they appear in the installation wizard. The wizard displays the status of the installation.

6. Click **Finish** to exit from the installation wizard.
7. Click **Finish** to exit from the installation wizard.

**Note:** For more details on installing HP OpenView New and Upgraded Smart Plug-ins, refer to the *New and Upgraded Smart Plug-ins CD for OpenView Operations Installation/Upgrade Guide*. 
Upgrading the hp OpenView storage area manager SPI

If you already have Storage Area Manager SPI version 03.21.21 installed on OVO 7.50 Management Server and want to upgrade to the version 03.30.000, complete the following steps on the OVO Management Server:

1. Install the hp OpenView Storage Area Manager SPI, version 03.30.000. For details, refer to page 32.

2. Setup Service Discovery of Storage Area Manager services. For details, refer to page 45.

Verifying the installation of the hp OpenView storage area manager SPI

To verify whether the installation of the Storage Area Manager SPI was completed successfully on the OVO management server, open the OVO console and check whether the following elements are present:

Table 6: OVO Elements

<table>
<thead>
<tr>
<th>OVO Console</th>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodes</td>
<td>OpenView-SAM_MgmtServer</td>
</tr>
<tr>
<td></td>
<td>OpenView-SAM_HA-Windows</td>
</tr>
<tr>
<td></td>
<td>OpenView-SAM_HA-UX</td>
</tr>
<tr>
<td>Tools</td>
<td>OpenView SAM</td>
</tr>
<tr>
<td>Policy Management</td>
<td>OpenView SAM</td>
</tr>
<tr>
<td>User Role</td>
<td>OpenView SAM Admin</td>
</tr>
</tbody>
</table>
Installed file locations

The installation process copies the necessary files to the OVO management server. Table 7 shows the directories that are created during the installation process of the Storage Area Manager SPI on the OVO management server.

Table 7: File Locations on the OVO Management Server

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVO integration</td>
<td>%OvInstallDir%install\OVSAMSPI</td>
</tr>
<tr>
<td>Documentation</td>
<td>%OvInstallDir%install\OVSAMSPI\doc</td>
</tr>
<tr>
<td>SPI-Share</td>
<td>%OvShareDir%SPI_Share\OVSAMSPI</td>
</tr>
<tr>
<td>MofFiles</td>
<td>%OvInstallDir%NLS\1033\MofFiles</td>
</tr>
</tbody>
</table>

Table 8 shows the directories for Storage Area Manager SPI components that are utilized on deployment of the policies to the OVOW managed node(s).

Table 8: File Locations for the OVO Managed Node

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Installed Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX, Solaris, Redhat Linux, SuSE Linux, Tru64</td>
<td>/var/opt/OV/bin/OpC/vpwin/monitor&lt;br&gt; /var/opt/OV/bin/instrumentation</td>
</tr>
<tr>
<td>Windows</td>
<td>%OvAgentDir%bin\OpC\vpwin\cmds&lt;br&gt; %OvAgentDir%bin\instrumentation</td>
</tr>
<tr>
<td>AIX</td>
<td>/var/lpp/OV/OpC/vpwin/monitor&lt;br&gt; /var/lpp/OV/OpC/instrumentation</td>
</tr>
</tbody>
</table>

**Note:** The Storage Area Manager SPI cmds, monitor and actions are copied into these paths only when the user deploys instrumentation to the managed nodes. For details refer to page 43.
Configuration

- Adding nodes to the nodes folder, page 38
- Installing the OVO agent, page 40
- Assigning user roles, page 41
- Deploying instrumentation to the nodes, page 43
- Setting up service discovery, page 45
- Setting up automatic acknowledgement, page 48
Adding nodes to the nodes folder

The first step in the configuration process is to add the Storage Area Manager management server and the nodes running the Host Agent to the Nodes folder.

**Note:** The Storage Area Manager SPI node groups are associated with the respective policy groups. So, when the nodes are added to the node groups, the policies relevant to that particular node are automatically deployed.

**Caution:** The automatic policy deployment requires that the OVO agent be present on the managed nodes. If the OVO agent is not present on the Windows nodes, the management server would deploy the agent automatically. For UNIX nodes, the agent should be installed manually. You can install the OVO agent by various methods on a managed node. For details, refer to page 40.

To add Storage Area Manager nodes to the Nodes folder:

1. Start the OVO console GUI.
2. Right-click the **Nodes** icon, point to **Configure** and select **Nodes...** from the submenu. The Configure Managed Nodes window appears.
3. Click the Storage Area Manager management server in the **Discovered Nodes** tree, drag it to the **Managed Nodes** tree, and drop it over the **OpenView-SAM_MgmtServer** folder.

4. Click the Windows Host Agent servers running Storage Area Manager Version 3.1/3.2 Host Agent in the **Discovered Nodes** tree, drag it to the **Managed Nodes** tree, and drop it over the **OpenView-SAM_HA-Windows** folder.

5. Click on the Unix Host Agent servers running Storage Area Manager Version 3.1/3.2 Host Agent in the **Discovered Nodes** tree, drag it to the **Managed Nodes** tree, and drop it over the **OpenView-SAM_HA-UX** folder.

6. Click **OK**.
Installing the OVO agent

Before starting the OVO agent installation, make sure that the system on which you want to install the OVO agent meets the hardware and software requirements described on page 28.

You can install the OVO agent by various methods on a managed node. For more detailed information about the various installation methods, refer to the *HP OpenView Operations for Windows Installation Guide*. 
Assigning user roles

This section describes how to assign the Storage Area Manager SPI user roles to users whom you intend to make responsible for the administration of Storage Area Manager SPI. For more information about User Roles, refer to page 64.

**Note:** Before assigning roles to the user, the user must be added to the HP-OVE-OPERATORS local group on the OVO management server. For more details, refer to the HP OpenView Operations Online Help.

To assign user roles:

1. Start the OVO console GUI and click on the **User Roles Configuration Editor** button located on the top menu bar of the main OVO GUI. The User Roles window appears.

![User Roles Window](image)

**Figure 5: User Roles Window**
2. Select **OpenView SAM Admin** and click on **Properties**...

   The User Role Properties window appears.

   ![User Role Properties Window](image)

   **Figure 6: User Role Properties Window**

   3. Select the **Users** tab and click on **Add**... button to add users to the role.
   4. Click **OK**.
Deploying instrumentation to the nodes

After the OVO agent has been successfully installed onto the OVO managed nodes, Storage Area Manager SPI commands and monitors have to be deployed to the nodes. Follow the steps below to deploy instrumentation on the Storage Area Manager managed nodes.

1. Right-click on each of the Storage Area Manager SPI node folders, point to All Tasks and select Deploy instrumentation. The Deploy Instrumentation window appears:

![Deploy Instrumentation Window]

2. Select Action, Command and Monitor.
3. Click OK.
Note: Ensure that the nodes are added to the node folders before deploying instrumentation to the nodes. To add nodes to the node folders, refer to page 38.
Setting up service discovery

The Storage Area Manager SPI has the ability to discover Storage Area Manager related services. The Storage Area Manager SPI discovers services using the Service discovery policies and instrumentation deployed on the Storage Area Manager bridge host. The Storage Area Manager SPI discovers the services automatically and uses the discovered data to generate service maps that can be viewed by the administrator from the OVO console. The service maps are updated once a day.

Note: For details on how to configure the OpenView SAM bridge, refer to chapter 7, “Configuring the Bridge,” in the hp OpenView storage area manager administrator’s guide.

To configure Service Discovery in your environment:

1. Logon to the OVO management server and open the command prompt window.
   
   To open the command prompt window, click Start -> All Programs -> Accessories -> Command Prompt.

2. Type `%OvInstallDir%install\OVSAMSPI\config\discovery\ovsamsd.bat` and press Enter. The following message is displayed:

   Starting to create ovsamsd.conf...

3. At the prompt

   'Enter the HP OpenView SAM username:'

   Type the Storage Area Manager username and press Enter.

Caution: Service Discovery will not function correctly if the values for the user name and password are incorrect. If you do not know the user name and password, contact your System Administrator.
4. At the prompt
   'Enter the HP OpenView SAM password:'
   Type the corresponding Storage Area Manager password and press Enter.
5. Confirm the password by re-entering the password at the prompt
   'Re-enter password:'
   The following message is displayed:
   Done creating ovsamsd.conf file.
6. Right-click on the Storage Area Manager bridge host and select All Tasks -> Deploy instrumentation.
   The Deploy Instrumentation window appears.

   ![Deploy Instrumentation Window](image)

   **Figure 8: Deploy Instrumentation Window**

   7. Select **OpenView SAM Hosts Discovery** and the **OpenView SAM Links Discovery** and click OK.
8. Right-click on the **OpenView SAM Service Discovery** policy group available in the OpenView SAM policy group and select **All Tasks -> Deploy on...**

The Deploy policies on... window appears.

![Deploy Policies on... Window](image)

9. Select the **Select nodes from the tree** option.
10. Select the Storage Area Manager bridge node by clicking on the box next to the node.
11. Uncheck the box **deploy policy only if version is newer**.
12. Click **OK**.

Service Discovery is now successfully set up in your managed environment.
Setting up automatic acknowledgement

The Storage Area Manager SPI has the ability to automatically acknowledge an event in the Storage Area Manager if the corresponding event is acknowledged in the OVO Events browser. To configure automatic acknowledgement:

1. Login to the OVO management server and open the command prompt window.
   
   To open the command prompt window, click **Start -> All Programs -> Accessories -> Command Prompt.**

2. Type `\%OvInstallDir\%install\OVSAMSPI\config\acknowledge\ovsamackn.bat` and press **Enter.** The following message is displayed:

   `Starting to create ovsamackn.conf...`

3. At the prompt

   `'Enter the HP OpenView SAM username:+'

   Type the Storage Area Manager username and press **Enter.**

   **Caution:** Automatic acknowledgement will not function correctly if the values for the username and password are incorrect. Note that the username that you configure should have Write capabilities on the Storage Area Manager management server. If you do not know the user name and password, contact your System Administrator.

   **Note:** HP recommends that you set up a Storage Area Manager user account specifically for this functionality and supply the user name and password to the person responsible for configuration of OVO.

   If there are multiple management servers in your environment, you will need to create the same user account(s) on each.

4. At the prompt

   `'Enter the HP OpenView SAM password:+'

   Type the corresponding Storage Area Manager password and press **Enter.**
5. Confirm the password by re-entering the password at the prompt
   'Re-enter password:'

   The following messages are displayed:
   Done creating ovsamackn.conf file.

6. Start the OVO Console GUI.

7. Right-click on the **Auto_Acknowledge_0301** policy present in the OpenView
   SAM policy group and select All Tasks -> Deploy on...

   The Deploy policies on... window appears.

   ![Deploy Policies on... Window](image)

   **Figure 10:** Deploy Policies on... Window

8. Select the **Select nodes from the tree** option.
9. Select the OVO management server node by clicking on the box next to the node.

10. Uncheck the box **deploy policy only if version is newer**.

11. Click **OK**.

   Automatic acknowledgement is now set up in your managed environment.
Using

- The hp OpenView storage area manager SPI node folders, page 52
- The hp OpenView storage area manager SPI tools, page 54
- The hp OpenView storage area manager SPI policies, page 56
- The hp OpenView storage area manager SPI messages, page 61
- The hp OpenView storage area manager SPI user roles, page 64
- The hp OpenView storage area manager SPI services, page 65
- The hp OpenView storage area manager SPI Self-Healing Services, page 68
The hp OpenView storage area manager SPI node folders

The installation of the Storage Area Manager SPI creates the following Nodes folders:

- OpenView-SAM_MgmtServer
- OpenView-SAM_HA-Windows
- OpenView-SAM_HA-UX

![Figure 11: Storage Area Manager SPI Node Folders](image)

The node groups are used for the SAN hosts in the Storage Area Manager environment. Drag and drop the Storage Area Manager nodes into the appropriate Node groups.
For more information on adding nodes to Node groups, refer to page 38. Table 9 below shows the association between the Nodes folder and relevant Tools folders.

**Table 9: Association of Tools Folder to Nodes Folder**

<table>
<thead>
<tr>
<th>Nodes folder</th>
<th>Tools folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenView-SAM_MgmtServer</td>
<td>ManagementServer</td>
</tr>
<tr>
<td>OpenView-SAM_HA-Windows</td>
<td>HostAgent-Windows</td>
</tr>
<tr>
<td>OpenView-SAM_HA-UX</td>
<td>HostAgent-UX</td>
</tr>
</tbody>
</table>
The hp OpenView storage area manager SPI tools

The installation of the Storage Area Manager SPI creates the Self-Healing Information tool and three Tool folders called ManagementServer, HostAgent-Windows, HostAgent-UX which contain a number of tools designed to help the OVO operator to manage the Storage Area Manager. The tools are grouped under a folder called OpenView SAM. The figure below shows the Storage Area Manager SPI Tools folder.

Figure 12: Storage Area Manager SPI Tools Folder
Table 10: Applications and their Descriptions

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ManagementServer Start/ManagementServer Stop</td>
<td>The Management Server Start and Management Server Stop applications provide a convenient way to start and stop the HP OpenView SAM Management Server service and HP OpenView SAM Embedded DB service from the operator’s console.</td>
</tr>
<tr>
<td>ManagementServer Status</td>
<td>The Management Server Status tool helps the administrator determine the status of the HP OpenView SAM Management Server service and the HP OpenView SAM Embedded DB service from the operator’s console.</td>
</tr>
<tr>
<td>Database Backup/Database Restore</td>
<td>The Database Backup and Database Restore applications invoke the backup and restore commands of Storage Area Manager.</td>
</tr>
<tr>
<td>Launch GUI</td>
<td>The Launch GUI application enables the user to launch the Storage Area Manager GUI from the operator's console.</td>
</tr>
<tr>
<td>Bridge Start/Bridge Stop</td>
<td>The Bridge Start and Bridge Stop tools provide a convenient way to start and stop the HP OpenView SAM Bridge service from the operator's console.</td>
</tr>
<tr>
<td>Bridge Status</td>
<td>The Bridge Status tool helps the administrator determine the status of the HP OpenView SAM Bridge service from the operator's console.</td>
</tr>
<tr>
<td>HostAgent Start/HostAgent Stop</td>
<td>From the operator’s system, you can start and stop the HostAgent service using HostAgent Start and HostAgent Stop applications.</td>
</tr>
<tr>
<td>HostAgent Status</td>
<td>The HostAgent Status is a tool that lets the operator determine the status of the HostAgent service from the operator's console.</td>
</tr>
<tr>
<td>OpenDial Start/OpenDial Stop</td>
<td>OpenDial Start and OpenDial Stop applications provide a convenient way to start and stop the OpenDial service.</td>
</tr>
<tr>
<td>OpenDial Status</td>
<td>The OpenDial Status is a tool that lets the operator determine the status of the OpenDial service from the operator's console.</td>
</tr>
<tr>
<td>Self-Healing Info</td>
<td>This tool allows the operator to gather predefined command output, configuration and log files on selected nodes of Storage Area manager SPI to facilitate effective troubleshooting.</td>
</tr>
</tbody>
</table>
The hp OpenView storage area manager SPI policies

All the policies provided with the Storage Area Manager SPI are grouped under the OpenView SAM policy group, as illustrated in Figure 13.

The Storage Area Manager SPI message-source policies intercept storage events, which are generated by various Storage Area Manager sub-systems and storage devices themselves. The storage events are forwarded to the OVO using the opcmsg() interface. Messages generated by the Storage Area Manager SPI policies pass through a filtration process and are then prioritized and assigned an OVO severity level as defined in the policies. All the messages generated by all the Storage Area Manager SPI policies belong by default to the OpenView-SAM message group. Additional monitor policies verify the status of the Storage Area Manager software service running on the Storage Area Manager management server and the HostAgent software running on the Storage Area Manager hosts, and generate messages to indicate any change in status.
The Storage Area Manager SPI supplies two policies that are used for Service Discovery. Deployment of the policies on the Storage Area Manager bridge server would enable the Storage Area Manager SPI to discover the service views supported by the Storage Area Manager. The services are:

- OpenView SAM Service
- Storage Links Service

**Note:** For details about how to configure the OpenView SAM bridge, refer to chapter 7 “Configuring the Bridge,” in the *hp OpenView storage area manager administrator’s guide.*

The Storage Area Manager SPI also supplies a policy that is used to acknowledge events in Storage Area Manager if the corresponding event is acknowledged in OVO.

The table below lists out all the default policies provided with the Storage Area Manager SPI.
Table 11: Default Storage Area Manager SPI Policies

<table>
<thead>
<tr>
<th>Policy Group</th>
<th>Policy Type</th>
<th>Policy Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ManagementServer</td>
<td>Logfile Entry</td>
<td>Storage_Events_0301</td>
<td>Analyzes and intercepts storage events from CS-EventExport.log file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logfile Entry</td>
<td></td>
<td>Acknowledge_Storage_Events_0301</td>
<td>Analyzes and intercepts acknowledged storage events from CS-EventAckDel Export.log file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measurement Threshold</td>
<td>Bridge_Service_0301</td>
<td></td>
<td>Monitors the process named 'BridgeServer' and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measurement Threshold</td>
<td>Management_Server_Service_0301</td>
<td></td>
<td>Monitors the process named 'ManagementServer' and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measurement Threshold</td>
<td>Embedded_DB_Service_0301</td>
<td></td>
<td>Monitors the process named 'solid' and sends a message to the event browser if not running.</td>
</tr>
</tbody>
</table>
Table 11: Default Storage Area Manager SPI Policies

<table>
<thead>
<tr>
<th>Policy Group</th>
<th>Policy Type</th>
<th>Policy Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HostAgent-Windows</td>
<td>Measurement Threshold</td>
<td>HostAgent_Service_0301</td>
<td>Monitors the process 'HostAgent' on Windows Storage Area Manager hosts and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td>Measurement Threshold</td>
<td>OpenDial_Service_0301</td>
<td>Monitors the process 'OpenDial' on Windows Storage Area Manager hosts and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td>Measurement Threshold</td>
<td>Hostwatchdog_Daemon_0301</td>
<td>Monitors the process 'hostwatchdog' on UNIX Storage Area Manager hosts and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td>Measurement Threshold</td>
<td>HostAgent_Daemon_0301</td>
<td>Monitors the process 'HostAgent' on UNIX Storage Area Manager hosts and sends a message to the event browser if not running.</td>
</tr>
<tr>
<td></td>
<td>Measurement Threshold</td>
<td>diald_Daemon_0301</td>
<td>Monitors the process 'diald' on UNIX Storage Area Manager hosts and sends a message to the event browser if not running.</td>
</tr>
</tbody>
</table>
Table 11: Default Storage Area Manager SPI Policies

<table>
<thead>
<tr>
<th>Policy Group</th>
<th>Policy Type</th>
<th>Policy Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Discovery</td>
<td>Service Auto-Discovery</td>
<td>Hosts_Discovery_0301</td>
<td>Discovers the Storage Area Manager management server and the hosts managed by the management server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Links_Discovery_0301</td>
<td>Discovers the links between various devices present in the storage domain managed by Storage Area Manager.</td>
</tr>
<tr>
<td>OpenView SAM</td>
<td>Windows Management Interface</td>
<td>Auto_Acknowlegde_0301</td>
<td>Acknowledges a Storage Area Manager event in the Storage Area Manager management server if the corresponding event is acknowledged in the OVO Message browser.</td>
</tr>
</tbody>
</table>
The hp OpenView storage area manager SPI messages

All events generated by the Storage Area Manager SPI are grouped into the message group OpenView-SAM. Figure 14 shows the message browser with the Storage Area Manager SPI messages. The messages generated by the Storage Area Manager SPI templates appear in the Message Browser window and contain information that is vital for the understanding of the problems being reported. The interpretation of the message severities is provided in the table below.

Table 12: Storage Area Manager Error Codes and OVO Severity Levels

<table>
<thead>
<tr>
<th>OVO Message Severity Level</th>
<th>Storage Area Manager Severity Level</th>
<th>Storage Area Manager SPI Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>Critical</td>
<td>A critical problem is detected that needs immediate attention.</td>
</tr>
<tr>
<td>Major</td>
<td>Major</td>
<td>A very significant event has occurred, where immediate attention is advised. Some parts of the system or device may have ceased functioning properly.</td>
</tr>
<tr>
<td>Minor</td>
<td>Minor</td>
<td>An event of some significance has occurred. Potential or impending problems have occurred that may escalate to become a serious problem.</td>
</tr>
<tr>
<td>Warning</td>
<td>Warning</td>
<td>A problem has been detected that should be corrected. This event is not likely to be escalated to a more severe condition.</td>
</tr>
<tr>
<td>Normal</td>
<td>Informational</td>
<td>A notable event has occurred, albeit one without any obvious detrimental effects. This is purely an informational event.</td>
</tr>
</tbody>
</table>
Figure 14: Storage Area Manager SPI Messages in the Message Browser

The figure above shows the Message Browser window with a selection of messages generated by the Storage Area Manager SPI. The message headline can give an idea of the scope of the problem. In the Storage Area Manager SPI context, this information can be broken down in the following way:

**Node** - The name of the Storage Area Manager management server.

**Application** - The category of the message. Possible categories are Device, Performance Capacity, Database, Allocator and Monitor.

**Text** - A single line description of the storage event.

**Object** - The source of the storage event.
Launching the Storage Area Manager GUI from the message browser

In an environment where Storage Area Manager Version 3.1/3.2 is managed, the operator has a choice of launching the Storage Area Manager GUI to further determine the cause of the problem and possibly correct it.

To launch the Storage Area Manager GUI:

- Select a Storage Area Manager event
- Right-click the event and select Commands -> Start -> Operator Initiated
- If the Storage Area Manager client is installed on the management server, the Storage Area Manager GUI starts up with the window context set to the appropriate panel in Storage Area Manager

**Note:** The operator needs to enter the user name and password of the Storage Area Manager management server, when prompted by the Storage Area Manager GUI, in order to access Storage Area Manager resources.
The hp OpenView Storage Area Manager SPI user roles

The installation of the Storage Area Manager SPI software adds a new user role called OpenView SAM Admin to OVO. The figure below illustrates the OpenView SAM Admin user role.

![User Roles](image)

**Figure 15: OpenView SAM Admin**

The OVO administrator utilizes user roles to simplify the process of assigning responsibilities to OVO users. The users associated with the role OpenView SAM Admin would have all the Storage Area Manager applications, policies and message groups assigned to them and would be able to manage and control the Storage Area Manager nodes.
The hp OpenView storage area manager SPI services

The Storage Area Manager SPI provides the user of the SPI with the additional perspective of Service Views. This integration provides the following Service views:

- OpenView_SAM_Service
- Storage_links

The Storage Area Manager SPI discovers the services automatically and uses the discovered data to generate service maps that can be viewed by the administrator from the OVO console. The figures below show the services discovered by the Storage Area Manager SPI.

Figure 16: Storage Links Service
Figure 17: OpenView SAM Service

The services discovered by the Storage Area Manager SPI allows root-cause analysis of any problems in the most crucial elements of the Storage Area Manager and the storage network being managed by Storage Area Manager. Propagation rules for the objects in the Storage Area Manager service trees are defined by default as Unchanged. This means that a parent service does not change the status of a child object by, for example, attaching a priority to it. Such a scenario would be feasible if a parent service considered the status of one child service to be more important than the status of another child service. Calculation rules for the Storage Area Manager service trees are set by default to Most Critical. This means that if a parent service has more than one child service, it assumes the status equal to the highest severity of its child services.
Viewing services

The service maps will be created a few minutes after the configuration of Service Discovery.

To view the discovered Services, click Services on the OVO Management Console and choose the appropriate service.

**Note:** By default, the services will be discovered by OVO once every day at 2:30 am. You can change the service discovery period by modifying the Service discovery policy. The changed discovery period will come into effect only after the policies are redeployed on the Storage Area Manager bridge.
The hp OpenView storage area manager SPI Self-Healing Services

The Storage Area Manager SPI has the ability to integrate with OpenView Self-Healing Services to provide improved troubleshooting. You can obtain troubleshooting information using one of the two methods:

■ **Self-Healing Information tool**

You can run this tool on any managed node supported by the Storage Area Manager SPI. Using this tool, you can gather data relevant to the fault and send it to HP support to diagnose the problem you face with the Storage Area Manager SPI.

■ **Self-Healing Services Software and Online support**

You can download the client software from the HP Software Support Online web site. Using this software and its web-linked capabilities, you can gather relevant troubleshooting data that you can use to investigate the problem on your own or submit to the HP secure web site for help. This web site contains a wealth of information, that can be used to solve the problem. The Self-Healing Services client software supports managed nodes running on Windows, HP-UX, and Solaris.

**Deploying OpenView SAM SHS Data Collector and SHS Data Collector**

To deploy the OpenView SAM SHS Data Collector and SHS Data Collector, complete the following procedure:

1. At the OVO console GUI, select and right-click on each of the Storage Area Manager SPI node folders on which you want to run the tool, point to All Tasks and select Deploy instrumentation.
The Deploy Instrumentation window appears.

![Deploy Instrumentation Window]

2. Select **OpenView SAM SHS Data Collector** and **SHS Data Collector**.
3. Click **OK**.

### Using the Self-Healing Information tool

You can use the Self-Healing Information tool on Management Server, Unix and Windows managed nodes. You can use this tool instead of the Self-Healing Services Client software that you can download from the HP software support web site.

The Self-Healing Information tool, like the client software, has the capability to gather troubleshooting data. However, unlike the client software, the Self Healing Information tool does not include an automated process to send the data to the HP
support center. After you run the tool, the data is saved in a compressed file. You must contact HP support and email the file based on the instructions you receive from the support center.

To use the Self-Healing Information tool, complete the following procedure:

1. At the OVO console, select **Tools -> OpenView SAM**.
2. Locate the **Self-Healing Info** tool, select and right-click **All Tasks -> Launch Tool**.
   The **Select where to launch this tool** window appears.

![Select where to launch this tool window](image)

**Figure 19: Launch Tool Window**

3. Select the Storage Area Manager SPI Management Server node, Unix or Windows managed node on which to deploy the tool.
4. Click **Launch**.
5. In the message that appears, note the file name and location where the gathered data is saved; then contact HP support for further instructions.

Self-Healing Services Software and Online support

Storage Area Manager SPI integrates with HP OpenView Self-Healing Services client software. The Self-Healing Services speeds up problem resolution by allowing you to quickly open an incident and send the data to a secure HP support site where it is stored for reference. If you choose, you can also request for an incident report from the support site. The support site organizes all troubleshooting information and makes the information available to you. As a result, you have access to a database of problems and resolutions that help you troubleshoot problems immediately.

Download the Self-Healing Services Software

To download the Self-Healing Services Client software, complete the following procedure:

1. Download the software from the HP OpenView Software Support Online web site at the following location:
   http://support.openview.hp.com/self_healing_downloads.jsp

   **Note:** Documentation for installing and using the Self-Healing Services is also available at this location.

2. Install Self-Healing Services on all managed nodes under Storage Area Manager SPI node folder that is running on supported operating systems. These operating systems include HP-UX, Solaris, and Windows.

Registering With Self-Healing Services Software

After installing and configuring Storage Area Manager SPI and Self-Healing Services software on each managed node, you must register Storage Area Manager SPI before using the tools.

The Self-Healing Register policy is automatically deployed when you deploy instrumentation on a new node. However, you must manually deploy instrumentation on nodes that are managed and that are on the management server. The policy runs a program every night, registering detected Smart Plug-in for use with Self-Healing Services.
To register Storage Area Manager SPI, complete the following procedure:

1. At the OVO console, select **Tools -> Self-Healing**.
2. In the Self Healing group, double-click **Self-Healing Register** and select the Storage Area Manager SPI nodes on which you want to launch the tool.
3. Click **Launch**.
4. Right-click on the Self-Healing Registration Scheduler policy available in the **Policy Management -> Policy groups -> Self Healing**.
5. Select **All Tasks -> Deploy on...**
   The Deploy policies on... window appears. See **Figure 9**.
6. Select the **Select nodes from the tree** option.
7. Select each Storage Area Manager SPI node on which you want to register Storage Area Manager SPI.
8. Clear the **deploy policy only if version is newer** box.
9. Click **OK**.
10. At each Storage Area Manager SPI nodes, restart Self-Healing Services so that Storage Area Manager SPI is detected and integrated with Self-Healing Services.

Whenever you have a problem with the operation of Storage Area Manager SPI, you can now go to the Self-Healing Services web page and open an incident. To open an incident, you open the Manual Submission page and choose **SPI_SAM** (Smart Plug-in for Storage Area Manager) from the drop-down list. The Self-Healing Services will automatically gather error-related data.

For more information on using Self-Healing Services, refer to Self-Healing Services manuals and online help at the following location:

http://support.openview.hp.com/self_healing.jsp
Troubleshooting

- Before you start, page 74
- OpenView SAM SPI messages not arriving on the OVO management server, page 75
- OpenView SAM services not visible in the OVO console, page 76
- Messages in the annotation field, page 77
- Context Sensitive GUI launch is not working, page 78
- Automatic Acknowledgement is not working, page 79
Before you start

Before you start investigating the problems that happen while installing, configuring, or using the Storage Area Manager SPI, you should carry out the following basic checks to ensure that the Storage Area Manager SPI environment is correctly installed and configured.

■ Carry out the steps recommended on page 32.

This ensures that you have installed and configured the Storage Area Manager SPI software in the recommended manner and that the messages seen in the OVO Events Browser are:

■ generated by the Storage Area Manager.
■ intercepted by the Storage Area Manager SPI templates and monitors, and
■ appearing in the OVO message browser in the form you expect.

If the preliminary check does not resolve the problems, go through the list of common problems and their solutions described below.
# OpenView SAM SPI messages not arriving on the OVO management server

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No OpenView SAM SPI messages arriving on the OVO management server.</td>
<td>Make sure that the connection between the OVO management server and the Storage Area Manager management server is up and running.</td>
</tr>
<tr>
<td></td>
<td>Send a test message from OVO console and ensure that it can be received in the OVO Events Browser. You can send a test message using the test tools available in the HP OpenView Operations console.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the Storage Area Manager Services are running on the Storage Area Manager management server.</td>
</tr>
<tr>
<td></td>
<td>Verify that the OVO agent has been correctly installed and configured on the management server and the OVO agent processes (and in particular the control agent) are running.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Storage Area Manager SPI policies have been correctly deployed to the Storage Area Manager SAN hosts. To check that the policies are correctly deployed, right-click on the host and Select View -&gt; Policy Inventory and ensure that the relevant Storage Area Manager SPI policies are present.</td>
</tr>
<tr>
<td></td>
<td>Make sure that Storage Area Manager nodes are added to the appropriate node groups. For more information, see page 38.</td>
</tr>
<tr>
<td></td>
<td>It is possible that the log file, CS-EventExport.log could have been rolled over more than once in an interval of 1 minute. This will result in the loss of all events in the old log files. For optimum results, retain the default threshold limit for the log file size. This value is set to 4 MB in the Storage Area Manager management server in the file Loggers.prp available under &lt;ManagementRoot&gt;\management server\config.</td>
</tr>
</tbody>
</table>
## OpenView SAM services not visible in the OVO console

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Area Manager Services are not visible in the OVO console.</td>
<td>Ensure that the Service Discovery policies have been deployed on the Storage Area Manager bridge server. To check that the policies are correctly deployed, right-click on the host and Select View -&gt; Policy Inventory and ensure that the Service Discovery policies are present. Make sure that the bridge is configured to include the list of management servers from which you want to gather data. Otherwise, data will be gathered only from the management server located on the same node as the bridge. For details on how to configure the Storage Area Manager bridge, refer to chapter 7, “Configuring the Bridge,” in the hp OpenView storage area manager administrator’s guide.</td>
</tr>
</tbody>
</table>
# Messages in the annotation field

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I get the following message in the Annotation field of events: “Service Desk integration is not present. Event would not be forwarded to Service Desk (SD)”</td>
<td>The Storage Area Manager SPI is tightly integrated with Service Desk, and the SPI will try to forward all events to Service Desk. The above message would be displayed if the SPI is unable to find the Service Desk integration. This message can be ignored if you do not intend to integrate Storage Area Manager with Service Desk. For details on how to integrate Storage Area Manager with Service Desk, refer to the <em>hp OpenView storage area manager Service Desk integration administrator’s reference</em>.</td>
</tr>
</tbody>
</table>
## Context Sensitive GUI launch is not working

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Sensitive GUI launch is not working</td>
<td>Ensure that the hp OpenView storage area manager client is installed on the OVO management server from where you are launching the GUI.</td>
</tr>
<tr>
<td></td>
<td>Context sensitive GUI launch is not supported on the OVO console. Ensure that you are launching the GUI from the OVO management server.</td>
</tr>
<tr>
<td></td>
<td>The OVO management server needs to be an authorized client to the Storage Area Manager management server where the event originated from. The OVO management server can be made an authorized client to the Storage Area Manager management server by adding a host entry in the authorizedClients.dat file on the Storage Area Manager management server. For details, refer to the <em>hp OpenView storage area manager administrator’s guide</em>.</td>
</tr>
</tbody>
</table>
## Automatic Acknowledgement is not working

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Acknowledgement is not working</td>
<td>Ensure that the hp OpenView storage area manager client is installed on the OVO management server.</td>
</tr>
<tr>
<td></td>
<td>Ensure that you have carried out the configuration steps. For more information, refer to page 48.</td>
</tr>
<tr>
<td></td>
<td>The OVO management server needs to be an authorized client to the Storage Area Manager management server where the event originated from. The OVO management server can be made an authorized client to the Storage Area Manager management server by adding a host entry in the authorizedClients.dat file on the Storage Area Manager management server. For details, refer to the <em>hp OpenView storage area manager administrator's guide</em>.</td>
</tr>
<tr>
<td></td>
<td>Automatic acknowledgement will not function correctly if the values for the username and password are incorrect. Note that the username that you configure should have Write capabilities on the Storage Area Manager management server. If you do not know the user name and password, contact your System Administrator.</td>
</tr>
</tbody>
</table>
Uninstalling

- Uninstalling the OpenView SAM SPI Policies from the OVO managed nodes, page 82
- Uninstalling the OpenView SAM SPI from the OVO management server, page 84
- Uninstalling the OpenView SAM SPI User Role from the OVO GUI, page 87
Uninstalling the OpenView SAM SPI Policies from the OVO managed nodes

To uninstall the hp OpenView Storage Area Manager SPI Policies from the OVO managed nodes, perform the following steps:

1. Start the OVO console GUI.
2. Select **Policy Groups > OpenView SAM** in the Policy Management folder.
3. Right click on the policy group **ManagementServer** and select **All tasks > Uninstall from...**
4. In the **Uninstall policies on...** window, select the node group **OpenView-SAM_MgmtServer** from which the policy has to be removed.
5. Select the **remove all versions** in the Deployment Options at the bottom of the Uninstall policies.
6. Click **OK**.
7. Right click on the policy group **HostAgent-Windows** and select **All tasks > Uninstall from...**
8. In the **Uninstall policies on...** window, select the node group **OpenView-SAM_HA-Windows** from which the policy has to be removed.
9. Select the **remove all versions** in the Deployment Options at the bottom of the Uninstall policies.
10. Click **OK**.
11. Right click on the policy group **HostAgent-UX** and select **All tasks > Uninstall from...**
12. In the **Uninstall policies on...** window, select the node group **OpenView-SAM_HA-UX** from which the policy has to be removed.
13. Select the **remove all versions** in the Deployment Options at the bottom of the Uninstall policies.
14. Click **OK**.
15. Right click on the policy group **Service Discovery** and select **All tasks > Uninstall from...**
16. In the **Uninstall policies on...** window, select the nodes from which the policies have to be removed.
17. Select the **remove all versions** in the Deployment Options at the bottom of the Uninstall policies.
18. Click **OK**.

19. Right click on the policy **Auto_Acknowledge_0301** and select **All tasks > Uninstall from...**

20. In the **Uninstall policies on...** window, select the **OVO server node** from which the policy has to be removed.

21. Select the **remove all versions** in the Deployment Options at the bottom of the Uninstall policies.

22. Click **OK**.

---

**Note:** To verify the OpenView SAM policies have been removed on the OVO console expand the Nodes folder, right-click a node, and select View -> Policy Inventory.
Uninstalling the OpenView SAM SPI from the OVO management server

To uninstall the hp OpenView Storage Area Manager SPI components from the OVO management server:

**Note:** Please ensure that OVO managed nodes are not present under Storage Area Manager SPI nodegroups. The nodes should be moved out of each of the nodegroups before uninstalling hp OpenView Storage Area Manager SPI.

1. Insert the *HP OpenView New and Upgraded Smart Plug-ins, volume 2* CD into the CD drive. The installation wizard appears.
2. Follow the instructions as they appear on screen and start the uninstall procedure by selecting the **Remove products** radio button.
3. In the Product Selection Uninstall window select **SPI for Storage Area Manager** and click **Next**. Figure 20 displays the SPI Uninstallation window.
4. Select **Remove**.
5. Click **Finish** to complete the uninstallation procedure and exit the wizard.

This will remove all the configuration files and executables of hp OpenView Storage Area Manager SPI from the OVO server. The hp OpenView Storage Area Manager SPI Node groups, Policies and Tools will also be removed from the OVO GUI.
Figure 20: Product Selection Uninstall window
**Note:** For more information on uninstalling HP OpenView New and Upgraded SmartPlug-ins, refer to the *New and Upgraded Smart Plug-ins CD for OpenView Operations Install/Upgrade Guide.*
Uninstalling the OpenView SAM SPI User Role from the OVO GUI

Some components of the hp OpenView Storage Area Manager SPI integrated in the OVO GUI will be automatically removed during the uninstallation of the product. The OpenView SAM Admin user role would have to be removed manually.

To remove the OpenView SAM Admin user role, perform the following steps:

1. Start the OVO console GUI and click the User Roles Configuration Editor button located on the top menu bar of the main OVO GUI. The User Roles window appears.

2. Select OpenView SAM Admin and click Delete to remove the OpenView SAM Admin user role from the OVO GUI.
Uninstalling